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Creating Web Pages - The Basics

Dreamweaver is a an HTML editor that allows you to create and edit web
pages without knowing any HTML code. It is similar to a text editor as it
allows you to create pages by typing the text and formatting it with the help
of menus and buttons.

The fist step in creating a web site is to plan it by asking yourself these simple
questions:

1. Why am I creating this Web site? What is it I want people to do or know
after they visit my site?

2. Who do I want my audience to be?
3. What information do I want to share with my Web site visitors?
4. What kind, if any, information do I want from my visitors?

5. How much time can I afford to spend maintaining my site?

Tips to know before you start designing:
1. Be sure to SAVE often!

2. The page you want to be displayed should always be named index.html.
This is because the web server automatically searches for and displays the
index page. There should be an index.html in every folder of your site.

3. When naming the pages of your site never use spaces, always use
lowercase letters, and use the .HTML extension. Keep in mind that the page
name will be part of a URL so name it appropriately.

4. When naming images, never use spaces and always use lowercase letters.
Graphic images are best saved as .GIF files and photos as .JPG files.
Remember that the bigger the image file, thel longer the download time.

5. When replacing pages on as existing site, make sure to name the new pages
the same as the old ones. This will reduce the number of broken links and



bookmarks.

6. When working on an existing page, make sure you have copied it to your
hard drive before making the changes to ensure that there are no accidental
deleting.

7. Keep your site design simple with all relative files and images together to
avoid numerous folders. Remember that the Web is not a storage area, so
remove any outdated files and images.

8. Frames are not user-friendly and should be avoided.

9. When your page is completed, make sure you test it in both the Internet
Explorer and Netscape browsers. Also, view it at 600 X 800 resolution to make
sure all you visitors can see the content.

Mapping a Drive:

First you must be able to connect to the network, which can be done by
mapping a drive.

Here are the steps you should follow:

Right click on "My Computer" and select MAP NETWORK DRIVE

Select a Drive letter ( W is the norm)

In the Path box type \\webserv\username

In the Connect AS box type your username

When you are on your own computer select the Reconnect at Logon box
Select OK , you should now be prompted for your username and password

gusrwNE

Now that your drive is mapped, create a folder called public_html, this is
where your web pages will be stored.

Editing an Existing Page:

Open Dreamweaver and choose Open from the file menu, but be sure to check
that the page on your hard drive is the same as the one on the server.

Starting a New Page:

Open Dreamweaver and File, New and name your page index.html. ( Index



is often used for home pages as most web servers are configured to display the
index.html file when no file name is specified. ) You should now add a title to
your page. Choose an appropriate name as it will be displayed in the upper-left
corner of your page.

* You may also add a title from the Modify / Page Properties menu.

Next imagine your page is divided into 3 sections:

1. Header ~ This is the top section of your page and should describe the
subject, it usually has a banner or image of some kind, a title and my contain
hyperlinks for navigation.

2. Body ~ This is the core of your page and should display the content or an
index of links to the available content.

3. Footer ~ This is the bottom of your page and should contain the Web site
builder's name and contact information, the date last revised, and any
copyright information. It may also contain hyperlinks.

Adding Color and Page Properties:

From the Modify menu, select the Page Properties option. Here you can set
the colors of the text, background, and links. You can also select an image as
a background, however, it will appear tiled if your image does not fill the page.
Keep in mind that this will also increase your download time.

Choose browser-safe colors as this will ensure that your page will be viewed
the same in all browsers. You can find a browser safe color chart at:
http://html.about.com/compute/html/library/bl_colors.htm

When choosing colors, avoid using dark colors which make it hard to print
the info, too many colors which can leave the page looking unprofessional,
and colors that fight with each other.

Adding a Header:

Select a Header style from the paragraph style drop-down menu on your
toolbar. Header 1 is the largest font and Header 6 is the smallest. This will
format your font as a title, but will not allow for anything else on the same
line. To place something beside a header, use a table.



Adding an Image:

Before you can insert an image, you must have one saved. For this example
go to www.mta.ca and right click on the MTA logo. Select Save Picture as
and save the image in the folder where your web page is located.

Click on the Image icon on the toolbar. Browse to the location where you
saved the MTA logo. If the image is not in the same directory as the page,
be sure to include the path. Once you have selected the image you have the
option of setting the properties. Here you can set the size of the image,
choose to add spaces or place borders around the image and make the
image a hyperlink.

Make sure that the image path does not include a drive letter like M:// as
this will cause the page to look to your computer for the image instead of
the folder on your web site. If this happens, simply delete everything in
front of the image name.

Always add a descriptive Alternate Text name to your images as some
browsers do not handle graphics and this will allow all visitors to understand
what is on your page. To add the text select the Alt Text option on the
image properties menu.

Remember to use meaningful images to enhance your site as decorations
merely distract from your content and make the download time slower.

Adding a Horizontal Line:

By selecting the Horizontal Line icon on your toolbar, you can create a
separator for the content on your page. Be careful not to use too many.

Inserting a Table:

Click on the Table icon on your toolbar. Here you can choose the number of
row, columns, the borders and the alignment.

If you are using a table to serve as a alignment tool only, you should set the



borders to 0 pixels so will not be visible when you page is viewed. Once your
table is created, it is helpful to place a character or two in each cell as a
place holder.

When deciding on the size of your table, remember that you should be
designing your page to fit in a 600l x 800w so your table should be no wider
than that to avoid horizontal scrolling, you may choose fixed width or
expanding tables which are described below.

Tables with a Fixed Width:

Advantages of fixed width tables include being somewhat sure of your layout
as it will not change as a user shrinks or expands their browser window.
However, you get horizontal scroll bars if the browser window is shrunk
narrower than the table. You also get “white” space beside your table if the
window is wider than the table.

To create a table with a fixed size simply click the arrow on the dropdown
box beside Table Width in the Table Properties box and choose pixels. Set
the number of pixels to the desired width.

Tables that Expand and Contract:

You don’t get horizontal scroll bars if the browser window is shrunk narrower
than the table. The table just shrinks with it. You also don’t get “white”
space beside your table if the window is wider than the table. The table
grows also.

However, your layout may change as the table changes. Text can wrap in
unexpected ways, especially when you have images with the text. You may
have to be very specific with cell or column widths so they do not mess up
your design.

To create a table with a width that is relative to the window simply click the
arrow on the dropdown box beside Table Width in the Table Properties box
and choose % of Window. Set the width to the desired percentage.

Spanning Rows and Columns:
You can achieve interesting layouts by making cells span multiple rows

and/or columns. To make a cell span across columns, highlight the cells and
select the join cells icon on the Table Properties box. Use the same method



to join rows.
Adding a Hyperlink:

Hyperlinks allow your visitors to quickly move from page to page or to
another site with a simple click of the mouse. Highlight the text or image
that you want to be a link and from the Modify menu select the Make Link
option or the link icon on your toolbar. Browse to the page you want to link
to or type the name of the file to which you are linking in the Link To box.
Make sure to include the whole path.

To link to an external site type or paste the URL in the Link To box.

Adding an Email Hyperlink:

Select the E-Mail icon from the properties toolbar and enter the e-mail
address and the text you wish to include. This will automatically launch the
visitors email program.

Inserting an Anchor:

Anchors allow you to create links to certain areas of your page. The most
common use of a target is a “"Back to Top” which helps limit scrolling on long
pages.

To create the anchor, highlight the text or place your curser in the location
that you want to link to and select the Anchor icon from the Invisibles
toolbar. Name the anchor appropriately, such as Top.

Next highlight the text (Back to Top) where you want the link to be located,
then click drag the wheel icon on the Properties box to the anchor tag on
your page. This will also add the link to your dropdown list on your
properties box.

The other way to link to an anchor is to highlight the text, select the Modify /

Make Link option and type # followed by the Anchor name in the link to box.
(#Top in this case).

Inserting a List:



There are 3 common types of lists; Bulleted, Numbered and Definition. To
create a list select a List from the Properties toolbar. Each time you hit
the enter key a new list item will be created. To exit the list, hit the enter
key twice.

Inserting Special Characters:

To insert a special character like a copyright symbol, select the Character
menu on the properties toolbar and click the appropriate icon or select
Special Characters from the Insert Menu.

Additional Tips & Resources:

1. Save often! Dreamweaver is a stable program, but crashes happen.

2. Always provide a link back to the source page

3. Use a template to keep your site consistent or use an existing page as
a starting point for a new one.

4, Avoid background images. Busy or high contrast backgrounds make
text difficult to read.

5. Limit the number of fonts you use on any page or site.
Choose two (maximum) fonts for a page and apply them consistently
to defined elements, i.e. one for headings, one for links, etc.

6. Test all the pages you create with Netscape Navigator and Microsoft
Internet Explorer.

7. Use the Spell Checker (in the Text menu)

8. Do not use the publish button. Use FTP to put pages on the server or
copy from your hard drive to the server share.

9. Putting all your web site files in the same folder greatly simplifies
linking and inserting of images. This is only true for small sites.

10. Keep pages simple. Do not use a lot of images and animations.

Resources:

Dreamweaver Training http://www.mta.ca/webmaster/dreamweaver.html
Education-World http://www.education-world.com/

SchoolSite http://www.schoolsite.com/

Canada’s SchoolNet http://www.schoolnet.ca/home/e/info/sitemap.html

Register here

http://www.schoolnet.ca/grassroots/e/schools.online/index.html

Design Tips http://www.mta.ca/comment/wwwcon/tips.html




Places to put your Web site:

nbnet (your own account - web space is free if you have internet service)
Canada’s SchoolNet http://www.schoolnet.ca/home/e/info/sitemap.html
List of free Web site hosts

Homestead - http://www.homestead.com/

Dreamwater - http://www.dreamwater.com/

(some put a banner ad on your page, some say they will pass your
information on to third parties)

Teacher Portfolios http://www.utexas.edu/academic/cte/teachfolio.html
or http://www.cte.iastate.edu/portfolio.html



Exercise: Create a web pages with the following elements

1. Create a page called index.html and give it a title such as "My Home
Page”.

N

. Change the background color of your page.

3. Create a title on your page using a header.

4. Insert some text such as "Welcome to my home page”.
5. Format the font by changing the color, size and style.
6. Make a list of items using bullets or numbers.

7. Make a target at the top of your page and a "Back to Top” link at the
bottom.

8. Insert a horizontal line near the bottom of your page.

9. Below the line create a “"Maintained by..” section with a link to your
email.

10. Create a second page with an appropriate name and title.

11. Insert a table with no visible borders, at least 2 columns and 2 rows and
align it to the center.

12. Make the top row into one by joining cells.

13. Insert the MTA logo and link it to www.mta.ca.

14. Insert an image and use the Alt Tag description.

15. Insert some text with Special Characters like a Copyright symbol.
16. Create a “"Back to Home” link to your main page.

17. Go back to your first page and create a “"Next Page” link to your second
page.





